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DIVISÃO DE GEOLOGIA ECONÔMICA 

INSTRUÇÃO TÉCNICA DIGECO 04/2022 

 

MODELAMENTO DE POTENCIAL MINERAL  

E MAPA DE FAVORABILIDADE 
 

1. INTRODUÇÃO 

A presente instrução técnica tem como finalidade apresentar os conceitos 

fundamentais e os procedimentos necessários para a elaboração de Modelos de 

Potencial Mineral, também denominados de Mapas de Favorabilidade ou 

Prospectividade Mineral. Os exemplos apresentados neste guia foram gerados no 

aplicativo ArcMap, da ESRI, versão 10, instalado em língua inglesa. Também está 

disponível um curso completo de Modelamento de Potencial Mineral, complementar à 

esta instrução técnica, através do seguinte link: 

 

https://drive.google.com/drive/u/3/folders/1ja0T9UTgYP4SXAw5OSnKO_IX6-_jK9WR 

 

2. CONCEITOS FUNDAMENTAIS 

2.1. Modelo de Potencial Mineral 

Modelos de Potencial Mineral (MPM) são tentativas de emular os processos 

formadores e dispersores de mineralizações, com finalidade de detectar novos alvos 

baseados em modelos de depósito mineral ou critérios do sistema mineral estabelecido. 

A grande vantagem desta abordagem é o desenvolvimento de uma METODOLOGIA 

REPRODUTÍVEL, visando identificar locais com alto potencial para exploração de uma 

commodity mineral (JOLY; PORWAL; MCCUAIG, 2012).  

Trabalhos de MPM têm a finalidade de representar, em mapas, áreas onde a priori 

há maior probabilidade de ocorrência de concentração mineral anômala, seguindo 

critérios prospectivos. Segundo a definição apresentada por Carranza (2009), a 

exploração mineral é composta de quatro fases: 

1  Seleção de área; 

2  Geração de alvos; 

3  Avaliação de recurso; 

4  Definição de reserva. 

Estes modelos podem ser aplicados às duas primeiras fases, geralmente 

respeitando as escalas associadas. A fase de Seleção de áreas corresponde à modelagem 
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em escala regional e busca delimitar áreas PERMISSIVAS ou FAVORÁVEIS à ocorrência 

mineral e onde a formação de um depósito próximo à superfície é plausível, baseada em 

um conhecimento prévio (CARRANZA, 2009). A fase de geração de alvos se dá a partir 

da demarcação das áreas PROSPECTIVAS, sendo composta de um mapeamento multi-

escala, partindo da escala regional ou semi-detalhe para a escala de detalhe, e indica 

áreas prospectivas a serem desenvolvidas baseadas em algum modelo de 

exploração/gênese de depósito. Ambas as etapas devem se basear em um conjunto de 

dados de naturezas diversas (geologia, geofísica e geoquímica). Tradicionalmente, cabe 

ao Serviço Geológico desempenhar atividades nas duas primeiras fases, com maior 

destaque para a primeira fase. 

O Modelo de Potencial Mineral pode ser construído com base em informações 

pré-definidas (modelo orientado pelo conhecimento ou knowledge-driven model) ou 

com base na assinatura de um depósito mineral conhecido (modelo orientado pelos 

dados ou data-driven model). Em outras palavras, pode-se desenvolver uma pesquisa 

mineral através de uma concepção regional de modelo geológico para a mineralização 

ou através da similaridade de condições com um depósito de minério que se tem 

conhecimento (CARRANZA, 2009; JOLY; PORWAL; MCCUAIG, 2012). 

Podem contribuir para a elaboração de modelos de potencial mineral dados de 

naturezas diversas dentro das geociências, como mapas geoquímicos uni- e 

multielementares, imagens geofísicas, mapas litológicos, mapas de interpretação 

estrutural ou outros. Estas camadas são geralmente avaliadas, previamente tratadas e 

convertidas para um formato adequado. No contexto de MPM, estas camadas recebem 

o nome de Mapas de Evidência, ou Mapas Evidenciais. 

 

2.2. Classificação de depósitos minerais 

Depósitos minerais são concentrações anômalas de algum elemento químico ou 

agregado mineral com valor econômico. Segundo Robb (2005), a melhor forma de 

classificar um depósito mineral é aquela onde os critérios se mantêm os mais 

independentes dos padrões genéticos (Figura 1) quanto possível, pois a gênese de um 

depósito pode envolver controvérsias e o conhecimento pode indicar outros caminhos 

com o surgimento de novos dados. Assim, a classificação relacionada aos processos 

críticos de depósitos minerais pode apresentar vantagens durante a modelagem de 

potencial mineral. 

O conceito de Sistemas Minerais, inicialmente desenvolvido por Wyborn et al. 

(1994), deriva do conceito análogo de Sistemas Petrolíferos, muito difundido na 

indústria do petróleo a partir de meados da década de 1980. Os Sistemas Petrolíferos 

categorizam todos os processos e elementos geológicos necessários para a formação e 

armazenamento de gás e petróleo. Da mesma forma, os Sistemas Minerais (Figura 2) 

foram definidos como “todos os fatores geológicos que controlam a geração e 

preservação de depósitos minerais, cujos processos são relacionados à mobilização do 
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minério desde a fonte até a região de concentração, transporte e acumulação, e sua 

posterior preservação ao longo da história geológica” (WYBORN; HEINRICH; JAQUES, 

1994). 

 

 
Figura 1. Classificação genética dos depósitos minerais de acordo com Robb (2005). 

 

 
Figura 2. Mecanismos de geração de depósitos minerais sob a ótica dos Sistemas Minerais 
(traduzido de HAGEMANN; LISITSIN; HUSTON, 2016). 
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3. TIPOS DE MODELAGEM E VALIDAÇÃO 

3.1 Introdução 

Os tipos de modelo de validação devem ser escolhidos de acordo com o objetivo 

do trabalho e a natureza e abundância dos dados disponíveis. Geralmente, trabalhos 

regionais, desenvolvidos em áreas pouco estudadas, limitam-se a modelos guiados pelo 

conhecimento prévio. 

É extremamente importante frisar que o tipo de método de integração escolhido 

tem um papel secundário na modelagem, sendo a qualidade, resolução e 

representatividade dos dados de entrada fundamentais para a qualidade do resultado. 

Os principais métodos de modelagens são: 

● Modelo Binário ou Booleano (BONHAM-CARTER, 1995); 

● Modelo de Index Overlay (BONHAM-CARTER, 1995); 

● Modelo Multiclass Index Overlay (BONHAM-CARTER, 1995); 

● Modelo de Lógica Fuzzy (ZIMMERMAN, 1991); 

● Modelo de Evidential Belief (AN; MOON; BONHAM-CARTER, 1994); 

● Modelos preditivos baseados em Machine Learning (RODRIGUEZ-GALIANO et 

al., 2015) 

 

3.2 Modelagem guiada pelo Conhecimento 

Os modelos orientados pelo conhecimento prévio são muitas vezes adequados 

para áreas novas para exploração, onde o conhecimento geológico é limitado 

(denominado pelo jargão da indústria como greenfield) ou as ferramentas disponíveis 

são escassas, sendo que os especialistas se baseiam em modelos clássicos de 

mineralizações, e tentam estimar o tipo de resposta esperada em cada ferramenta 

utilizada. Se a conjunção de respostas for como esperada, gera-se um alvo a ser 

verificado, caso contrário, troca-se o modelo de mineralização ou a área é descartada. 

Estes modelos têm a vantagem de serem mais versáteis, porém são tendenciosos e 

dependem da qualidade e natureza dos dados avaliados, da experiência da equipe de 

prospecção e da similaridade entre os depósitos (CARRANZA, 2009). 

 

3.3 Modelagem guiada pelos Dados 

Os modelos orientados por dados, ou também modelos empíricos, são mais 

complexos, sendo construídos numericamente pelo conjunto de dados fornecidos e são 

usados para prever, não para explicar as mineralizações. Um modelo empírico simula 

uma função matemática que captura a tendência dos dados. Essa tendência, ou padrão, 
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pode ser inferida pela análise e interpretação direta, ou com a ajuda de lógica 

computacional pré-compilada (como Algoritmos de Aprendizado de Máquina ou 

Machine Learning Algorithms – MLA), que podem dar uma resposta não tendenciosa 

para o problema envolvido (CARRANZA, 2009). 

 

3.4 Validação 

Dada a compreensão limitada dos processos envolvidos na formação de depósitos 

minerais e modelos geológicos muitas vezes inconclusivos, eventualmente mais de um 

modelo de potencial mineral se ajusta aos conceitos e dados disponíveis. Desta forma, 

a validação se faz necessária para selecionar o modelo que apresenta maior eficiência 

em prever novos alvos. Existem diversas formas de validar modelos prospectivos ou de 

favorabilidade, tanto para modelos tipo knowledge-driven quanto data-driven. Neste 

tópico iremos apresentar uma das opções disponíveis para validar modelos 

prospectivos, que consiste na comparação entre as áreas mapeadas pelas classes de 

favorabilidade e a porcentagem da área mapeada com ocorrências minerais (Figura 3). 

 
Figura 3. Etapas de validação de Modelo de Potencial Mineral com ilustração das tabelas com 
proporção de área e ocorrências cobertas pelas classes de favorabilidade (modificado de 
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Carranza 2009). Abaixo, gráfico com curvas representando a variação na detecção dos depósitos 
e da área de pesquisa. 

 

A eficiência da modelagem prospectiva pode ser medida a partir da comparação 

entre o número de ocorrências de ouro inseridas em cada uma das classes de 

favorabilidade geradas (que podem ser categorizadas numericamente de 1 a 10, por 

exemplo). Para isso, inicialmente é necessário exportar a tabela de atributos contendo 

a reclassificação do raster do modelo que se quer validar. Esta planilha vai conter uma 

coluna com a contagem de pixels (‘count’) que será transformada em porcentagem para 

ser comparada com a área mapeada com ocorrências minerais.  

Em seguida, com o auxílio da ferramenta Sample (Spatial Analyst) as ocorrências 

minerais conhecidas são agrupadas de acordo com as classes de favorabilidade 

previamente selecionadas.  

A tabela resultante do Sample será exportada para o Excel onde os valores de área 

(pixel count) serão transformados para porcentagem. Desta forma, é possível gerar os 

gráficos de área mapeada versus área com ocorrências minerais. 

 

4. ESTRUTURAÇÃO DE DADOS DE ENTRADA 

4.1 Nomenclatura de Arquivos 

A nomenclatura de arquivos deve seguir determinados padrões que visem evitar 

conflito com a linguagem utilizada pela plataforma adotada (ArcMap, QGIS, etc.). Além 

disso, a sistematização de nomenclaturas auxilia na organização e no compartilhamento 

dos dados. As sugestões são descritas a seguir: 

● Evitar usar “espaços em branco” no nome de pastas e arquivos. Para tal, são 

recomendadas algumas alternativas, como i) iniciar nova palavra com letra 

maiúscula (ex: UpperCamelCase) e ii) separar as palavras utilizando o caractere 

especial “underscore” (ex: upper_camel_case); 

● Tentar manter o comprimento do “pathname” (endereço do arquivo) menor 

do que 128 caracteres. Uma boa sugestão é criar a pasta de trabalho direto no 

diretório “C” (ex: C:\MPM\bruto\ISA.tiff), ou na área de trabalho (Desktop); 

● Evitar utilizar acentuação ou cedilha em nome de arquivos ou na tabela de 

atributos. Isso evita problemas de compatibilidade da linguagem de 

programação utilizada para a construção do software (Encoding); 

● Evitar palavras que possam causar conflito com termos SQL (usados pelo GIS), 

ex. de nomes a evitar: SELECT, VALUE, CONT, NOT, OR, ON, IN, OVER; 

● Em uma tabela de atributos, o nome dos campos deve conter menos de 10 

caracteres; 

● Nomes de arquivos Raster devem começar com letras e é sugerido que tenham 

até 13 caracteres para que possam ser abertos pelo GRID da ESRI. Mesmo 



 
DIGECO – Instrução Técnica: Modelamento de Potencial Mineral e Mapa de Favorabilidade IT-04/2022 
 

7 

 

quando outra plataforma for utilizada, é importante manter esse padrão para 

evitar problemas de compatibilidade. 

 

4.2 Sistema de Coordenadas e Datum 

Para que o processamento ocorra sem problemas, é necessário que todas as 

camadas de trabalho estejam georreferenciados com coordenadas planas, sob um 

sistema de projeção UTM e com o mesmo Datum. De acordo com o Decreto 3.045/2005, 

e a Resolução 1035 IBGE de 2005, desde 2015 o Sistema Geodésico Brasileiro de 

referência é o SIRGAS-2000 (Figura 4). Portanto, este Datum deve ser adotado para 

todas as camadas. 

Para definir o Sistema de Coordenadas e o Datum de um projeto no ArcMap, clique 

com o botão direito sobre o Layer > Propriedades > Sistema de Coordenadas > Sistema 

de Coordenadas Projetadas > UTM > América do Sul > SIRGAS 2000 e selecione o Datum 

adequado para a área. 

 

 
Figura 4. Tela de definição de Sistema de Coordenadas. 

 

4.3 Organização da Pasta de Trabalho (Workspace) 

A sistematização na organização da pasta de trabalho, ou workspace, facilita o 

resgate dos arquivos utilizados e o trabalho em equipe. É necessário lembrar das regras 

de nomenclatura apresentadas no tópico 3.1, principalmente no que diz respeito a 

caracteres especiais e espaço entre palavras. Apresentamos aqui uma sugestão de 

organização da pasta de trabalho (Figura 5), porém a escolha deve ser aquela onde a 
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equipe se sinta confortável, sendo somente imprescindível a adoção de uma 

padronização: 

● Bruto: arquivos originais de processamentos, servindo como um repositório 

dos dados de entrada para o caso de ser necessário voltar o processamento; 

● Final: arquivos de saída dos modelos; 

● Raster: arquivos matriciais pós-processados; 

● shp: arquivos vetoriais pós-processados; 

● Temp: pasta de processamento de arquivos temporários. 

 

 
Figura 5. Exemplo de estruturação da pasta de trabalho. 

 

É de extrema importância a criação de um memorial do projeto, onde todos os 

arquivos gerados são registrados na forma de um “log” de processamento. Etapas de 

geração dos arquivos matriciais como interpoladores, filtros e parâmetros de 

geoprocessamento ou algoritmos de álgebra de mapas deverão ser descritos permitindo 

a sua reprodução posterior (Figura 6). 
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Figura 6. Exemplo de arquivo tipo “LEIA-ME” com descrição de metadados do projeto, lista de 
arquivos utilizados, descrição dos interpoladores, tamanho de células e filtros aplicados nos 
arquivos tipo raster. 
 

5. GERAÇÃO DE MAPAS DE EVIDÊNCIA 

5.1 Introdução 

O modelamento de favorabilidade mineral parte de um modelo conceitual, que 

prescreve a participação de variados processos ou controles geológicos na formação de 

depósitos do tipo buscado. A evidências podem ser retiradas de fontes variadas, 

principalmente de dados geoquímicos, geofísicos e geológicos. 

Os mapas de evidência devem refletir os fatores críticos na formação, transporte, 

acumulação e preservação do bem mineral buscado, de forma que ao menos um dos 

mapas de evidência represente cada etapa ou fator crítico considerado no modelo 

conceitual de formação dos depósitos (ou sistemas minerais). A exemplo citam-se 

mapas de classificação de unidades geológicas favoráveis, metamorfismo, arcabouço 

estrutural (interpretação de produtos magnetométricos, análise de proximidade de 

estruturas), alteração hidrotermal (análise de produtos gamaespectrométricos, 

evidências coletadas em campo), contatos intrusivos e distribuição de elementos em 

sedimento de corrente e concentrado de bateia. 

Como os pacotes de processamento do ArcGIS são limitados pela disponibilidade 

e tipo de licença, pode se fazer necessário processar dados matriciais em plataformas 

suplementares. A alternativa que fornece experiência de usuário mais semelhante à 

fornecida pelo Spatial Analyst, do ArcMap, é o Processing Toolbox do QGIS. 
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5.2 Ferramentas de Geoprocessamento 

As ferramentas de processamento de dados geográficos convencionais são as 

plataformas SIG desenvolvidas para este propósito, como ArcMap ou ArcGIS pro, que 

são aplicativos desenvolvidos pela ESRI com diversos tipos de licença que controlam o 

acesso às extensões como Spatial Analyst e outras; QGIS, um projeto colaborativo open 

source de processamento de dados espaciais que tem evoluído bastante recentemente, 

além de outras aplicações independentes, como Orange, ou scripts de análise e 

processamento de dados que rodam diretamente em linguagens de programação. 

As ferramentas de geoprocessamento são divididas em operações locais, de 

vizinhança e zonais (TOMLIN, 2012). Dentre as diversas ferramentas disponíveis, as mais 

usuais são as operações de fatiamento (buffering), distância e densidade (Figura 7). 

A função Álgebra de mapas é a ferramenta do ArcMap para geração de produtos 

baseada em relações matemáticas simples de arquivos raster. Para o cálculo devido, os 

arquivos matriciais inseridos na ferramenta devem ter a mesma extensão (dimensões e 

tamanho de pixel), sistema de coordenadas planares com mesmo datum e não possuir 

“buracos” no raster, como dados ausentes (missing values). 
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Figura 7. Principais ferramentas utilizadas no ArcMAP para gerar mapas evidenciais a partir de 
feições lineares e seus respectivos caminhos no arc toolbox: (a) Buffer  (Analysis Tool > Proximity 
> Buffer); (b) Buffer de Anéis Múltiplos (Analysis Tool > Proximity> Multiple Ring Buffer ); (c) 
Densidade Kernel (Spatial Analyst Tools > Density > Kernel Density ); (d) Distância Euclidiana 
(Spatial Analyst Tools > Distance > Euclidean Distance); (e) Densidade de Linhas ( Spatial Analyst 
Tools > Density > Line Density). 
 

Para acessar a ferramenta de álgebra de mapas, deve-se abrir o ArcToolbox > 

Spatial Analyst Tools > Map Algebra > Raster calculator. Como alternativa, a ferramenta 

Raster Analysis do QGIS apresenta funções nativas úteis e simples, como transformação 

Fuzzy, operações booleanas nativas, cálculo de volume e diversas opções de 

reclassificação (Figura 8). 
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Figura 8. a) Localização da ferramenta Raster Calculator, do pacote Map Algebra, dentro do 
ArcToolbox, no ArcMAP versão 10.6; b) Painel de ferramentas de processamento do QGIS versão 
3.17 – Bucarest, com opções para análise estatística de dados matriciais. 
 

6. CONFECÇÃO DO MAPA DE FAVORABILIDADE 

O layout do mapa de favorabilidade deve seguir o modelo apresentado na Figura 

9, e a seguir serão detalhados os principais elementos do mapa, como encartes 

essenciais, legendas, simbologias padrão e mapas de evidência a serem apresentados, 

bem como o posicionamento desejável de cada um destes elementos. O modelo de 

layout editável será disponibilizado aos usuários nos formatos PDF e MXD. O formato 

PDF em tamanho original será anexado à presente instrução técnica. No formato MXD, 

o usuário poderá editar e confeccionar seu mapa a partir do modelo criado pela DIGECO 

para o ArcGIS, facilitando o processo construtivo do mapa. 

 
Figura 9. Layout padrão do mapa de favorabilidade, destacando-se os principais elementos. 
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6.1 Criação de Data Frames 

Os data frames são quadros de dados que contêm uma coleção de layers ou 

camadas de informação empilhadas, a fim de compor os encartes que exibem temas 

específicos relativos à área pesquisada. Para o mapa de favorabilidade, os data frames 

podem ser de cinco tipos principais: tectônico, evidências do modelo, mapa principal, 

localização e articulação da área. A figura 10 mostra o índice destes data frames, 

geralmente disposto ao lado esquerdo da janela de trabalho no ArcMap. 

 
Figura 10. Índice de data frames do mapa de favorabilidade, agrupados nas cinco seções 
principais. Vale ressaltar que o número de data frames contendo mapas de evidência é variável, 
de acordo com a necessidade do projeto. 
 

 Data frame Tectônico: é opcional, pois o encarte tectônico pode ser 

representado tanto por um data frame, quanto por uma figura. No caso de 

opção por data frame, o mesmo deve conter camadas de associações ou 

domínios tectônicos, da estruturação regional principal, de dados de 

planimetria (principais localidades, rodovias e drenagens, limites estaduais ou 

internacionais quando houver) e o polígono da área do projeto. Um segundo 

data frame pode ser adicionado para localizar a área do encarte tectônico em 

relação ao território brasileiro ou à plataforma sulamericana. 

 Data frames Evidenciais: Estes data frames representam os encartes temáticos 

do modelamento, e devem conter os mapas evidenciais, alguns dados de 

planimetria (principais localidades, rodovias e drenagens) e os recursos 

minerais utilizados para treino e/ou teste do modelo, com simbologia 
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simplificada (ver item 5.4). O número de data frames evidenciais é variável de 

acordo com os critérios da equipe executora do modelamento. 

 Data frame do Mapa principal: corresponde ao mapa de favorabilidade em si, 

e nele deverão ser acrescentados o modelo final de favorabilidade, dados da 

geologia da área, estruturas medidas e interpretadas (pontos e linhas), recursos 

minerais e dados de planimetria (localidades, vias de acesso, drenagem unifilar 

e bifilar). 

 Data frame de Localização: segue o padrão de procedimentos apresentados na 

Instrução Técnica DIGEOB 08, pág. 5 (link). 

 Data frame de Articulação: segue o padrão de procedimentos apresentados na 

Instrução Técnica DIGEOB 08, pág. 5 (link). 

 

6.2 Simbologia de Convenções Cartográficas 

As simbologias das convenções cartográficas a serem aplicadas nos arquivos de 

planimetria (localidades, rodovias, drenagens) são aquelas definidas pela Divisão de 

Cartografia da CPRM (DICART), explanadas no MTC 01.01 – 10, tópico 3 (link). A figura 

11 exemplifica a simbologia padrão. 

 

 
Figura 11. Exemplo de simbologia de convenções cartográficas. 

 

6.3 Simbologia de Convenções Geológicas 

A simbologia de feições lineares e pontuais de estruturas, utilizada no mapa de 

favorabilidade, segue os procedimentos descritos na Instrução Técnica DIGEOB 08, 

página 5 (link). 

 

6.4 Simbologia de Convenções de Recursos Minerais  

Os recursos minerais apresentados no mapa de favorabilidade devem ter ligação 

com o modelo proposto e a substância mineral buscada. Por exemplo, se o modelo é de 

favorabilidade para ouro, os recursos minerais serão as ocorrências de ouro. A 

simbologia destes recursos no mapa principal são aquelas definidas pela DIGECO, cuja 

fonte e instruções de montagem constam na Instrução Técnica DIGECO 02 (Mapa de 

Recursos Minerais). Um exemplo desta simbologia é mostrado na Figura 12. 

Adicionalmente, recomenda-se a representação dos recursos minerais em todos 

os encartes de mapas evidenciais, a fim de que sejam melhor visualizadas as relações 

entre os depósitos e as regiões delineadas como favoráveis nos mesmos. Em função do 

tamanho dos encartes ser consideravelmente menor, e considerando a complexidade 

http://intra.cprm.gov.br/publique/media/guias_orientativos/dgm/instrucoes_tecnicas_e_padroes_jul_2020/gpt_2020_it_digeob_08_mapa_geologico_layout_shapes_atributos_01_07_2020.pdf
http://intra.cprm.gov.br/publique/media/guias_orientativos/dgm/instrucoes_tecnicas_e_padroes_jul_2020/gpt_2020_it_digeob_08_mapa_geologico_layout_shapes_atributos_01_07_2020.pdf
http://intra.cprm.gov.br/publique/media/docs_normativos/mtc010110_mapas_layouts.pdf
http://intra.cprm.gov.br/publique/media/guias_orientativos/dgm/instrucoes_tecnicas_e_padroes_jul_2020/gpt_2020_it_digeob_08_mapa_geologico_layout_shapes_atributos_01_07_2020.pdf
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da simbologia padrão de recursos minerais, recomenda-se o uso de simbologia 

simplificada nestes encartes, por meio da representação de pequenos círculos na cor 

branca (Figura 12). 

 

 
Figura 12. Exemplo de representação dos recursos minerais no mapa principal e nos encartes 
de mapas evidenciais. 
 

6.5 Escala de cor 

Tanto os mapas evidenciais quanto o mapa final de favorabilidade são inseridos 

em formato raster e necessitam de uma escala de cor que represente adequadamente 

regiões de maior a menor potencial para hospedar depósitos do tipo buscado. As escalas 

podem ser utilizadas de forma contínua (dados contínuos, ex. distância euclidiana, 

funções fuzzy) ou discreta (classes de dados, ex. classificação de unidades litológicas, 

dados de geoquímica). 

Não há um padrão de cor fixo para os mapas de favorabilidade. No entanto, 

recomendamos o cumprimento de alguns pontos na escolha da escala de cor, a saber: 

● Pouca variação de cor (preferencialmente com três cores principais, sendo duas 

nas extremidades e uma intermediária); 

● Variação que evolua de cores frias (verde, azul) a cores quentes (vermelho, 

laranja); 

● Usar o mesmo padrão de cores para dados contínuos e dados de classes; 

● Usar o mesmo padrão de cores para os mapas de evidências e para o mapa 

principal; 
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● Pode-se optar pela supressão dos valores mais baixos e ênfase para os valores 

de maior interesse, redistribuindo as cores da escala escolhida e explicitando a 

operação na legenda do encarte. 

Na Figura 13 são apresentados exemplos de escala de cores recomendadas pela 

DIGECO, bem como escalas de cores inadequadas para este fim. A escala de cor que tem 

sido mais utilizada nos mapas de favorabilidade da CPRM é a “Prediction”. 

 

 
Figura 13. Escalas de cor recomendadas pela DIGECO, e exemplos de escalas de cor inadequadas 
para utilização nos encartes do Mapa de favorabilidade. 
 

A apresentação dos índices de favorabilidade no mapa final pode ser tanto na 

forma de categorias classificadas, quanto como faixa contínua de valores (Figura 14), a 

critério dos autores observando a aderência ao tipo de modelo gerado. 

 

 
Figura 14. Formas de representação dos índices de favorabilidade do modelo final. 

 

6.6 Encartes e Elementos do Layout 

Os encartes e elementos padrão em mapas do Serviço Geológico também 

dispostos no Mapa de Favorabilidade são: encarte tectônico, localização e articulação 

da área, descrição das unidades litoestratigráficas, convenções cartográficas e 

convenções geológicas, créditos, títulos, escala e outras informações de confecção do 

mapa. Tais encartes e informações seguem o padrão proposto na Instrução Técnica 

DIGEOB 08 (link).  

http://intra.cprm.gov.br/publique/media/guias_orientativos/dgm/instrucoes_tecnicas_e_padroes_jul_2020/gpt_2020_it_digeob_08_mapa_geologico_layout_shapes_atributos_01_07_2020.pdf
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A seguir serão discutidos os encartes e elementos específicos do mapa de 

favorabilidade: 

● Encarte “Evolução Geodinâmica e Metalogenia”: tem posição preferencial à 

esquerda do mapa principal, mas também pode ser alocado na parte inferior 

do mapa. Neste encarte é requisitado que se desenvolva um texto, 

descrevendo resumidamente a evolução tectônica da área, os estilos de 

mineralização e os eventos mineralizadores em ordem cronológica. Em 

complemento a este texto, podem também ser apresentadas opcionalmente 

figuras esquemáticas e tabelas ilustrativas desta evolução; 

● Encarte “Controles dos depósitos – Mapas de Evidência”: tem posição 

preferencial à esquerda do mapa principal. Neste encarte situam-se os diversos 

mapas de evidência do modelo, em quantidade variável. Cada mapa de 

evidência necessita de título, escala e legenda próprios. Opcionalmente podem 

também ser apresentados mapas ou modelos intermediários.  

● Encarte “Integração de Dados e Favorabilidade”: tem posição livre no layout, 

embora seja preferível que esteja à direita dos mapas de evidência. Este 

encarte é composto por um texto explicando, de maneira sucinta, o método de 

integração utilizado (ex. Multiclass Overlay, lógica fuzzy, pesos de evidência, 

etc.) e os resultados obtidos. Este texto deve vir acompanhado de uma tabela 

descritiva dos parâmetros de geração dos mapas de evidência, listando em seus 

campos todos os mapas envolvidos na modelagem, os critérios de classificação 

considerados pela equipe executora (ex. proximidade com contatos de corpos 

intrusivos), ferramentas de processamento (ex. distância euclidiana) e os 

parâmetros do método de integração utilizado. Sugerimos, como 

complemento, a apresentação das informações em forma de fluxograma 

indicando as etapas e funções de modelamento utilizadas para se gerar os 

mapas de evidência e chegar ao modelo final de favorabilidade. 

● Encarte “Validação do Modelo”: tem posição livre no layout, embora seja 

preferível que esteja na sequência do encarte de integração de dados e 

favorabilidade. Neste encarte é imprescindível a apresentação de um pequeno 

texto explicativo das etapas e métodos utilizados para testar a eficiência e 

performance do modelo preditivo, e os resultados obtidos. Adicionalmente, os 

testes devem ser apresentados em forma de gráficos (ex. ROC/AUC, SCP);   

● Legenda “Recursos Minerais”: tem posição livre no layout. A legenda deve 

explicitar todas as classificações embutidas na simbologia, e suas instruções de 

montagem estão detalhadas na Instrução Técnica DIGECO 02 (Mapa de 

Recursos Minerais);  

● Tabela “Relação dos Recursos Minerais”: tem posição livre no layout. Esta 

tabela deve conter campos com a numeração dos recursos contidos no mapa, 

nome (ou toponímia), rochas hospedeiras, rochas encaixantes, unidade 
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estratigráfica, controle estrutural, tipo (garimpo, depósito) e recursos globais 

(medidos, indicados e inferidos), caso haja em pelo menos um depósito na área; 

● Legenda “Índices de Favorabilidade”: tem posição preferencial acima do título 

do mapa. A forma de apresentação varia de acordo com o mapa, conforme 

mostrado na Figura 14.  

 

6.7 Mapa Principal 

No mapa principal, as camadas de informação devem estar dispostas na seguinte 

ordem, de cima para baixo: 

1. Camadas de recursos minerais; 

2. Camadas de localidades e vias de acesso (a primeira sobreposta à segunda); 

3. Camadas de estruturas; 

4. Camadas de drenagem; 

5. Camada da geologia, cuja apresentação é feita com os polígonos sem 

preenchimento e contorno cinza 20% e espessura 1; 

6. Modelo de favorabilidade em formato raster. 

Os recursos minerais devem ser apresentados de modo que os símbolos não se 

sobreponham, a fim de evitar poluição visual e perda de qualidade da informação. É 

necessária a inserção de anotação do número de cada ponto, relativo ao depósito a ser 

identificado na tabela de recursos minerais (exemplo na Figura 12).  

As estruturas em ponto devem ter suas respectivas anotações, com atenção à 

legibilidade das mesmas (evitar conflitos com outras informações no mapa). 

A camada de geologia, embora sem as cores características das unidades, deve 

conter as anotações das suas respectivas letras-símbolo dentro dos polígonos, grafadas 

na mesma cor do contorno.  

 

6.8 Mapas de Evidência 

O modelamento de favorabilidade mineral parte de um modelo conceitual, que 

prescreve a participação de variados processos ou controles geológicos na formação de 

depósitos do tipo buscado. A evidências podem ser retiradas de fontes variadas, 

principalmente de dados geoquímicos, geofísicos e geológicos. 

Os mapas de evidência devem refletir os fatores críticos na formação, transporte, 

acumulação e preservação do bem mineral buscado, de forma que ao menos um dos 

mapas de evidência represente cada etapa ou fator crítico considerado no modelo 

conceitual de formação dos depósitos (ou sistemas minerais). A exemplo citam-se 

mapas de classificação de unidades geológicas favoráveis, metamorfismo, arcabouço 

estrutural (interpretação de produtos magnetométricos, análise de proximidade de 

estruturas), alteração hidrotermal (análise de produtos gamaespectrométricos, 
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evidências coletadas em campo), contatos intrusivos e distribuição de elementos em 

sedimento de corrente e concentrado de bateia. 

 

7. COMPARTILHAMENTO DE DADOS VETORIAIS 

7.1 Geodatabase 

Um geodatabase é uma ferramenta de gestão de dados SIG construído como uma 

forma de banco de dados relacional. Diferente das pastas de trabalho ou Workspace, 

um geodatabase faz o gerenciamento de dados baseado em ficheiros próprios, ou 

datasets. O geodatabase apresenta vantagens na gestão do sistema de coordenadas dos 

dados, na verificação de inconsistências de topologias e no controle de modificação. Um 

arquivo geodatabase pode ser do tipo de usuário único ou múltiplos usuários e isso deve 

ser definido durante a conceituação do projeto. 

Para criar um arquivo geodatabase, deve-se acionar a extensão Catalog, do 

ArcGIS, como uma aba do ArcMap ou pelo acesso direto, e selecionar a opção de criar 

novo arquivo através do botão direito do mouse (Figura 15). 

 

 

Figura 15. Criação de um arquivo tipo geodatabase no diretório de saída “final”, na pasta de 
trabalho. O arquivo é criado pela extensão Catalog e as camadas (Dataset) são organizadas por 
tema. 
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7.2 Map Package (arquivo “mpk”) 

Um arquivo tipo Map Package (extensão “.mpk”) é uma forma prática de 

compartilhar arquivos utilizados na plataforma ArcMap. Ele agrupa as camadas de dados 

e simbologia atribuída, como um arquivo de projeto (.mxd), porém agregando também 

ao arquivo todas as feições de fonte dos dados, sendo assim mais fácil de ser 

compartilhado. A desvantagem é que geralmente os arquivos com extensão “.mpk” 

tendem a ocupar muito espaço no disco e é comum que ultrapassem o limite de 

tamanho de anexo dos correios eletrônicos ou serviços de mensagem, sendo necessário 

compartilhamento por outros meios. 

Para criar um arquivo tipo Map Package, selecione File > Share As > Map Package, 

sendo necessário preencher os campos de metadados para ser liberado o 

compartilhamento (Figura 16). 

 

 

Figura 16. Caminho para a criação de um arquivo Map Package no ArcMap na versão em inglês. 

 

8. RECOMENDAÇÕES FINAIS 

8.1 Citação e Referenciamento 

Ao se utilizar um arquivo publicado anteriormente (mesmo que de autoria da 

própria equipe), é necessário fazer a citação da fonte do arquivo. Material contido ou 

publicado conjuntamente com os mapas de potencial mineral pode fazer referência aos 

capítulos onde foram discutidos com maior abrangência. 

Para normatização interna sobre citação e referenciamento, verificar Guia de 

Citações NBR 10520:2002 com exemplos em geociências (PAULA, 2015) e o Guia de 
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Referências, baseado na NBR 6023:2002 (FREIRE, 2012), ambos organizados pela Rede 

Ametista de Bibliotecas da CPRM. 

 

8.2 Fluxograma de Produção e Correção 

É desejável que o processo de criação de mapas de potencial mineral siga um 

fluxo de trabalho que foi definido visando garantir a padronização do conteúdo e da 

forma de apresentação do produto gerado. Este fluxo é ilustrado na Figura 17: 

 

 
Figura 17. Fluxograma de produção e indicação das etapas de correção mínimas para a 
publicação de Modelos de Potencial Mineral. 

 

8.3 Diretrizes para Publicação 

Após finalizada as etapas de produção e correção, o mapa de potencial mineral 

e o texto explicativo gerado devem ser enviados pelo chefe de Projeto ou equipe de 

produção (com ciência do mesmo) para o GEREMI ou seu correspondente nas 

residências. Este deve encaminhar para os responsáveis da DIGECO e DEREM, para que 

encaminhem para o pessoal responsável pela publicação. 
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Anexo I - Layout Mapa de Favorabilidade.zip
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